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Foreword 

The ShapeMaker plugin is a tool which facilitates the creation of Vector Shapes, Lines and Curves. 

The tool itself uses a WYSIWYG interface where Lines, Curves and entire Paths can be created and 

manipulated using just the mouse.  Knowledge of the complex vector code structure is not required.  

ShapeMaker will create all that complex stuff for you and generate the Shape, code, or a complete reusable 

file. 

 

Definitions used in this guide 

Circle – a compound type consisting of two semi-circular Ellipses. 

Compound Types – One of two shapes (Rectangle and Circle) which are composed of individual elements to 

create the Shape.  A Rectangle is composed of four Straight Lines and a Circle is two semi-circular Ellipses.  

These two compound types are included to ease drawing these common shapes. 

Control nub – a little graphic representing a draggable control point. 

Contiguous – a line or curve which starts from the same point where another ends. 

Curve – any one of a number of Curve types which extend between two points (Start and End).  In 

ShapeMaker Curves have one or more control nubs which can be used to alter them. 

Drawing Grid – the square space where Lines, Curves and Paths are created and edited. 

Ellipse – a special type of Curve.  Ellipses create their own individual Path and cannot be joined in a series 

like the other types. 

End point – the place where a Line or Curve terminates. 

Line – a straight Line between two points:  Start point and End point. 

Mid point – any point occurring in a Path that is not a Start or End point. 

Path – a series of continuous connected Lines or Curves of the same type.  Ellipses and Circles cannot be 

joined in series to create a Path. 

Path List – the contents of the Path pane.  Paths created are listed here - just like paint.net's Layers window. 

Primitive Types – one of the Line/Curve types: Straight Line, Cubic Bézier, Quadratic Bézier or Ellipse. 

Rectangle – a compound type consisting of four parallel Straight Lines. 

Shape – the object created from all the Paths in the Path List. 

Smooth Types – a subset of Curves which interact with neighboring Curves in the same Path to make the 

overall Curve continuously smooth.  There are two Smooth types: Smooth Cubic Bézier and Smooth Quadratic 

Bézier. 

Start point – the place where a Line or Curve begins. 
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ShapeMaker User Interface (UI) 

The ShapeMaker UI can be divided into five main areas: 

1. Menus - File, Edit and Help. 

2. Toolbar - with icons for various Lines, Curves and options. 

3. Drawing Grid - where Shapes are created. 

4. Path List, Editing Tools & Options. 

5. Status Bar. 
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File Menu 

This menu contains basic file handling options.  The menu can be opened by clicking on it or using the 

keyboard combination Alt + F. 

 

 

New Project 

Creates a new blank project and clears the Undo buffer. 

Open Project… 

Loads a previously saved ShapeMaker file.  The Shape defined in the file is loaded into the Path List and 

shown on the Drawing Grid. Opening a project will clear the Undo buffer. 

Open Recent Project 

Loads a previously saved ShapeMaker file from a list of recent project files.  The Shape defined in the file is 

loaded into the Path List and shown on the Drawing Grid. Opening a project will clear the Undo buffer. 

Save Project…  

Saves the current Shape as an xml file in a proprietary ShapeMaker format.  This format preserves all 

line/curve definitions in Path List.  This feature is particularly useful if you wish to continue editing the Shape at 

some later date. 

Import Geometry... 

Allows Geometry to be imported from several formats: Paint.NET shape files, standard XAML files, Android 

Vector Drawable files, and SVG files. 

Note: As its name implies, only the geometry information will be imported. No colors, fills, strokes, ect. 

Export 

These first two entries allow for saving the current Shape in a paint.net compatible (XAML) format. These 

Shapes are stored in the Paint.net\Shapes\ directory. 
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Note:  You will need to restart paint.net to use a newly saved Shape as they are only loaded on startup. 

PDN Shape (StreamGeometry)... 

Saves the Shape to an XAML file using the StreamGeometry format. 

PDN Shape (PathGeometry)... 

Saves the Shape to an XAML file using the more complex PathGeometry format. 

SVG... 

Saves the Shape to an SVG file. 

Copy StreamGeometry 

Copy Path Stream copies all the Paths in the Path List to the clipboard for pasting elsewhere.  Use this option 

to export StreamGeometry outside of the paint.net environment. 

Paste StreamGeometry 

Paste Path Stream is used to copy code from a SVG file into ShapeMaker.  Open the SVG file with your 

favorite text editor and copy the code between the Path tags then in ShapeMaker, use File > Paste Path 

Stream to paste the Shape into the Drawing grid and Path List. 

 

Paste Path is capable of interpreting StreamGeometry strings which are a lightweight version of PathGeometry 

strings.  Both can appear in XAML files - but only StreamGeometry can be parsed by ShapeMaker.  Users 

attempting to paste in PathGeometry strings will receive an error message even though there is nothing 'wrong' 

with the string. 

 

For further information can be found on the distinction between the two string formats using these links: 

 

Geometry Overview 

https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-

multimedia/geometry-overview 

 

StreamGeometry Tutorial 

https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/how-

to-create-a-shape-using-a-streamgeometry 

 

PathGeometry Tutorial 

https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/how-

to-create-a-shape-by-using-a-pathgeometry 

  

https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/geometry-overview
https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/geometry-overview
https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/how-to-create-a-shape-using-a-streamgeometry
https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/how-to-create-a-shape-using-a-streamgeometry
https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/how-to-create-a-shape-by-using-a-pathgeometry
https://docs.microsoft.com/en-us/dotnet/articles/framework/wpf/graphics-multimedia/how-to-create-a-shape-by-using-a-pathgeometry
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Edit Menu 

The Edit menu contains editing tools to manipulate the current Line/Curve, Path or Shape.  The menu can be 

opened by clicking on it or using the keyboard combination Alt + E. 

 

 
 

Items in the Edit menu are disabled when they would have no effect (Delete Path and Clone Path in the image 

above). 

Some of these commands have different effects depending on whether a Line/Curve is actively being edited.  

This table should clarify some of these differences. 

 

 Edit Buffer Empty Line/Curve Active New Line/Curve 

Delete Path N/A yes no 

Clone Path N/A yes no 

Loop Path no yes yes 

Flip Horz yes yes yes 

Flip Vert yes yes yes 
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Undo (Ctrl + Z) 

Undo rolls back the last changes made in reverse order.  The last change made is the first removed.  The 

change might have been the creation of, or modification to, a point, Line, Curve or Path. 

Undo has a maximum of 15 plies or levels meaning it will not reverse more than 15 changes. 

Redo (Ctrl + Y) 

Redo reverses actions which have been undone using Undo. Actions reversed are reapplied in the same order 

they were originally performed. 

Remove Path (Delete key) 

Erases the currently highlighted Path from the Path List. 

Clone Path 

Creates a duplicate of the currently highlighted Path.  The duplicate is drawn on top of the existing Path; move 

the new Path to relocate it (Shift + drag any nub). 

Loop Path (Ctrl + 1) 

Relocates the End point of the highlighted Path to the same location as the Start point of the Path.  This is a 

simple way to close a Shape. 
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Flip Horizontal 

When a Line/Curve is actively being edited, this command mirrors the entire Line/Curve horizontally. 

 

 
Before after Flip Horizontal 

 

When no Line/Curve is active, Flip Horizontal flips the entire Shape. 

 

 
Original Shape     Following Flip Horizontal 
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Flip Vertical 

When a Line/Curve is actively being edited, this command mirrors the entire Line/Curve vertically. 

 

 
 

When no Line/Curve is active, Flip Vertical flips the entire Shape. 

 

 
 

Operations Box (Ctrl + M) 

Toggles the visibility of the Operations Box. 

 

 
 

Auto Scale Shape 

Scales the entire shape so that it fills the center of the Drawing Grid.  
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Help Menu 

The Help menu can be opened by clicking on it or using the keyboard combination Alt + H. 

 

 

User's Manual  

Opens this user manual using the installed PDF viewer.  The PDF is bundled with ShapeMaker.  The PDF file 

should be placed in the paint.net/Effects/ folder along with the ShapeMaker dll in order to make it available 

from within ShapeMaker. 

Quick Start Guide 

The Quick Start guide is designed to get you up and running with ShapeMaker.  It takes you through the major 

features as you're guided through creation of a simple Shape. As with the User Guide, the Quick Start PDF 

should be placed in the paint.net/Effects/ folder to make it available from within ShapeMaker. 

Keyboard Shortcuts 

Opens a window with three tabs. The first shows Keyboard shortcuts. 

 

 
 

The second tab shows Mouse & Keyboard combinations. 
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About  

Shows the following dialog with copyright and author details. 
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Toolbar 

The Toolbar contains a number of icons which are used to change the drawing tool and provides some options 

for how the current Line, Curve or Path behaves. 

 

 
 

 Undo (Ctrl + Z) 

The Undo button rolls back the last changes made in reverse order.  The last change is the first removed.  The 

change might have been the creation of, or modification to, a point, Line, Curve or Path. 

Undo has a maximum of 15 plies or levels meaning it will not reverse more than 15 changes.  

 Redo (Ctrl + Y) 

Redo reverses actions which have been undone using the Undo button. Actions reversed are applied in the 

same order they were originally performed. 

 Straight Lines (Ctrl + L) 

Creates Straight Lines between Start and End points. See Straight Line (Ctrl + L) 

 Auto Rectangle (Ctrl + R) 

Creates a Rectangle between Start and End points. See Auto Rectangle (Ctrl + R) 

 Cubic Bézier (Ctrl + B)  

Creates a Cubic Bézier Curve between Start and End points. See Cubic Bézier (Ctrl + B) 

 Cubic Spline (Ctrl + P) 

Transforms Cubic Béziers into Cubic Splines. See Cubic Spline (Ctrl + P) 

 Smooth Cubic Bézier (Ctrl + Shift + B) 

Creates a Smooth Cubic Bézier Curve between Start and End points. See Smooth Cubic Bézier (Ctrl + Shift + 

B) 
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 Quadratic Bézier (Ctrl + Q) 

Creates a Quadratic Bézier Curve between Start and End points. See Quadratic Bézier (Ctrl + Q) 

 Smooth Quadratic Bézier (Ctrl + Shift + Q) 

Creates a Smooth Quadratic Bézier Curve between Start and End points. See Smooth Quadratic Bézier (Ctrl + 

Shift + Q) 

 Elliptical Arc (Ctrl + E) 

Creates an elliptical arc between Start and End points. See Elliptical Arc (Ctrl + E) 

 Large/Small Arc Selector 

Toggles which portion of an Elliptical Arc is drawn. See Elliptical Arc (Ctrl + E) 

 Sweep Direction 

Reverses the direction of the Elliptical Arc. See Elliptical Arc (Ctrl + E) 

 Auto Circle (Ctrl + I) 

Creates a Circle whose diameter is set by Start and End points. See Auto Circle (Ctrl + I) 

 Snap to Grid (Ctrl + S) 

This toggle forces new points and points being dragged onto Drawing Grid boundaries.   

If Snap-To-Grid is enabled, a new point will be created on the nearest grid boundary.  If Snap-To-Grid is 

disabled the point will be created where the mouse cursor is located.  Similarly when dragging a point, grid 

boundaries will be forced if Snap-to-Grid is enabled. 

Existing points are not relocated by this button. 

 Linked with Previous Path (Ctrl + 3) 

When enabled, this function preserves the focus on the last created End point when the Add Path button is 

clicked. This feature allows the next Line/Curve to be drawn from the same point.   

If this feature is disabled, clicking Add Path removes the focus from the entire previous object. 
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 Close Individual Path (Ctrl + 2) 

When the Closed Path feature is engaged, any path being drawn will automatically be closed with a straight 

Line from the current End point back to the Start point.  

Enable Closed Path if you wish to create a closed path automatically.  Disengage the Closed Path feature to 

leave a path open. 

 

The straight line between the Start point and End point will be drawn with dashes in the color gray. 

 

 
Closed Path Disabled   Closed Path Enabled 

 

If an individual Path is closed using this feature, a loop will appear about the black square to the right of the 

Path name in the Path List. In the diagram below, the Quadratic Béziers path is closed on itself. 
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 Close Contiguous Paths (Ctrl + Shift + 2) 

If Closed Paths is enabled, ShapeMaker will close the current linked Paths with a straight line. It does this by 

backtracking along contiguous (linked) Paths until a start nub is found (i.e. the origin of the series of connected 

Paths). 

 

The straight line between the Start point and End point will be drawn with dashes in the color gray. 

 

     
  Close Contiguous Paths disabled   Close Contiguous Paths enabled 

 

If a series of contiguous Paths is closed using this feature, the black squares to the right Path name in the Path 

List will be joined with a loop indicator. The loop indicator joins the first and last paths. 

 

In the diagram below the Smooth Quadratic Béziers path has been automatically closed with the preceding 

linked path(s).  

 

 
 

If there are no linked paths, Close Contiguous Paths acts in the same way as Close Individual Path. 

  



ShapeMaker User Guide – 19 

 

Drawing Grid 

The Drawing Grid is where Lines and Curves are drawn to create Paths and Shapes. 

 

 
 

When a Line, Curve or Path is active on the Drawing Grid, the Start point is drawn as a triangle outline, the 

End point is drawn as a square outline, and the line is given a subtle glow.  This is to identify the Path and the 

direction. 
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When contiguous Paths meet, the connecting Start/End nub is drawn as a filled shape instead of an outline. 

 

 
 

 

The Drawing Grid is set to a default grid size. The grid dimensions cannot be altered.  If you want to zoom in 

on the Grid, click the Zoom button or use the Mouse wheel with the pointer over the Drawing Grid.   

 

 
 

Available Zoom levels are 1x, 2x, 5x and 10x. Repeated clicking on the Zoom button will cycle through all the 

zoom levels then cycle from 10x back to 1x. 

When Zoom is enabled, the scrollbars or Click + drag using Mouse wheel allows the Shape and background 

to be panned around the drawing grid.  

 

If Snap-To-Grid is enabled , new points and points being dragged around the Drawing Grid will be forced 

onto the Grid boundaries.  This is useful for creating straight lines and aligning points. 

If Snap-To-Grid is disabled , new points will be created where the mouse cursor is located.  When 

dragging a point the Grid is ignored. 

Note that the Drawing Grid is not rendered to the paint.net layer or output with any file saved by ShapeMaker.  

Its purpose is simply to aid the actual creation of Shapes. 
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Path List 

Path List 

The Path List contains a list of all the Paths that have been committed to the Shape. 

 

On the far-right, black squares indicate which paths are Linked and Closed. Linked paths are joined with a 

straight line connecting the squares. Closed paths have the start and end squares joined with a loop indicator. 

 

 
 

The Path List operates much like paint.net's Layers Window.  Paths can be reordered, cloned, flipped, deleted, 

looped, and re-edited. 

 

From left the icons at the foot of the Path List are: 

 Move Path Up 

 Move Path Down 

 Clone Path 

 Delete Path 
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To focus the editing operations on a specific Path - click on the Path in the Path List.  The selected Path will 

become editable on the Drawing Grid with all associated Control Nubs activated (the Path will be placed in the 

editing buffer). 

 

The Path Names in the Path List are automatically generated.  These can be changed by double-clicking on 

the Path in the Path List.  A dialog opens allowing a new text string to be entered. 

 

 
 

Custom Path Names are saved along with the Shape only when saved as a ShapeMaker Project (File > Save 

Project). 

 

If an individual Path is closed using the Close Individual Path feature, it will be indicated in the Path List. 

 

 
 

Similarly, closing a series of contiguous Paths with the Close Contiguous Paths feature will also be indicated in 

the Path List. 
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  Move Path Up/Down Arrows 

ShapeMaker supports reordering of the entries in the Path List.  The correct order of Paths is necessary to 

close a Shape when using an automated fill to color the Shape. 

Highlight a Path in the Path List and click the arrows to shift the Path higher or lower in the list.  The arrows are 

enabled only when a Path is highlighted in the Path List. 

 Clone Path 

Creates a duplicate of the currently highlighted Path.  The duplicate is drawn on top of the existing Path; move 

the new Path to relocate it (Shift + drag any nub).  

 Delete Path 

Erases the currently highlighted Path from the Path List. This acts the same as Edit > Remove Path (Delete 

Key). 

Deselect (Esc Key)  

 
This button removes the editing focus from the last object's End point.  In other words it deselects the currently 

active Path. 

 

Add Path (Enter Key) 

 
Commits the current path to the Path List. 

 

Discard Path (Esc Key) 

 
Discards the currently edited path, as long as it has not been committed to the Path List. Useful for starting 

over if a path has gone bad. 
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Image Tracing 

Image Tracing Opacity 

 
 

This slider determines the opacity of the active paint.net layer which is shown behind the drawing grid.  This 

feature allows the layer to be used as a base for tracing. 

 

 
 

Fit Background 

 
 

If Fit Background is checked, the background layer is scaled to fit within the grid space.  The height and width 

ratio is maintained.   

If the feature is disabled (button not highlighted), the unscaled layer is either centered in the drawing grid 

space (if less than 500px square) or aligned to the top left corner (if greater than 500px square). 

PDN Layer / Clipboard (Source Image) 

 
 

These radio buttons determine if the image used as a background (for tracing purposes) will be sourced from 

the active paint.net layer or the clipboard. 
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Shape Properties 

Shape Name 

This textbox is used to name your Shape.   

 
 

In paint.net this name will be used as a tool tip when the Shape is hovered over in the Custom Shapes menu. 

 

 
 

If a Name has been specified in the Name box it will be used to pre-populate the File Save dialog when saving 

the Shape to file. 

Solid Fill 

 
 

This checkbox switches between the F0 and F1 fillRules in the StreamGeometry and PathGeometry formats. 

 

When unchecked, the fillRule is set to F0 (EvenOdd).  As this is the default fillRule it is left out of the actual 

Path e.g.  

M 150,110 L 290,110,290,200,150,200,150,110 

Is the same as 

F0 M 150,110 L 290,110,290,200,150,200,150,110 

 

Using the F0 fillRule, a series of concentric circles is rendered this way 

 
When checked, the fillRule is set to F1 (Nonzero).  F1 is stated at the start of the Path e.g.  

F1 M 150,110 L 290,110,290,200,150,200,150,110 
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Using the F1 fillRule, a series of concentric circles is rendered this way 

 
 

For further information on these fillRules, see: 

 

Path Markup Syntax (Microsoft)  

https://docs.microsoft.com/dotnet/framework/wpf/graphics-multimedia/path-markup-syntax 

 

FillRule Enumeration (Microsoft) 

https://docs.microsoft.com/dotnet/api/system.windows.media.fillrule 

  

https://docs.microsoft.com/dotnet/framework/wpf/graphics-multimedia/path-markup-syntax
https://docs.microsoft.com/dotnet/api/system.windows.media.fillrule


ShapeMaker User Guide – 27 

 

Draw on Canvas 

Draw on Canvas 

The Draw on Canvas checkbox renders the current Shape to the active layer. 

 

 
 

This feature is intended as a quick way to render a Shape to the active layer.   

 

Clipping Regions 

If the canvas is a different size to the ShapeMaker Drawing Grid (aka the Editing Window), cross-hatched 

clipping regions will be shown indicating the edges of the canvas. Any portion of the Shape extending into a 

clipping region will not be rendered.  

 

Clipping regions are not shown when the Fit to Canvas checkbox is checked, as this option scales the Shape 

to fit inside the canvas boundaries. 
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Colors 

 
 

These are the primary (left) and secondary (right) colors used by the Shape. Click on the colored square to 

select a new color.  

Note: The Secondary is only used when the Draw Mode is set to Outline & Filled. 

Outline Width 

 
 

This sets the width of the Outline of the Shape’s paths. 

Note: The Outline Width value has no effect when the Draw Mode is set to Filled. 

Draw Mode 

 
 

There are three modes to choose from:  

● Outline - draws the path(s) outline using the primary color. 

● Fill - fills enclosed regions with the primary color. 

● Outline & Fill - draws the outline in the primary color, and fills any enclosed regions with the secondary 

color. 

Fit to Canvas 

 
 

This checkbox affects the scaling of the Shape in relation to the Paint.NET canvas. 

 

If you are doing a tracing, you should leave Fit to Canvas unchecked. The Shape will be scaled proportionally, 

so that your trace lines/paths line up with your image.  

 

If Fit to Canvas is checked, the Shape is scaled up as much as possible while still fitting inside the canvas 

boundaries. 
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OK Button 

The OK button is used to terminate the current ShapeMaker session.  

 

 
 

If Draw on Canvas is enabled, the current Shape will be rendered to the current paint.net layer.   

If Draw on Canvas is disabled clicking OK will simply close the plugin.  Remember to save your work!  As a 

fail-safe, the current Shape will be reloaded into the Drawing Grid and Path List if the plugin is reopened within 

the same paint.net session. 
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Status Bar 

Underneath the Drawing Grid is the status bar. When drawing is begun, the number of nodes and Paths is 

shown along with the maximum number available, active nub location and the zoom level. 

 

 

Nubs Used 

The total number of nubs used is shown. There can be a maximum of 255 nubs in any single Path.  

 

Paths Used 

Displays the number of Paths in the shape. 

 

Nub Location 

The location of the last added, removed, or moved nub is shown in the status bar. 

 
The X coordinate is the distance from the left hand side of the drawing grid.  The Y coordinate is the distance 

from the top of the drawing grid. 

Mouse Cursor Location 

Show the coordinates of the mouse cursor in the Drawing Area. 

 

Zoom Level 

 
 

This split button in the Status Bar sets the magnification Drawing Grid.  1x, 2x, 5x and 10x magnification are 

available to assist when fine tuning Shapes and nub positions. 

Repeatedly clicking the zoom split button in the Status Bar cycles through all the zoom levels then starts over. 

If the Alt button is held down while clicking on the zoom button, the cycle direction is reversed. 

The Zoom level can also be set by scrolling the Mouse wheel in the Drawing Area. 
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Drawing Types 

 

There are four Primitive types, two Smooth types and two Compound types.   

 

Primitive Types - Straight Line, Cubic Bézier, Quadratic Bézier and Ellipse. 

Smooth Types - Cubic Spline, Smooth Cubic Bézier and Smooth Quadratic Bézier. 

Compound Types - Rectangle and Circle. 

 

These are the basic building blocks from which Shapes are formed.  If the same type is linked in a series the 

resultant "string" is called a Path.   

 

Think of the relationship Lines/Curves > Paths > Shapes like the relationship Words > Sentences > 

Paragraphs. I.e. in written or spoken language, consecutive words are used to create sentences. Consecutive 

sentences create paragraphs.  

word + word + word... = sentence 

sentence + sentence + sentence... = paragraph 

 

In ShapeMaker, consecutive Lines or Curves (words) of the same type create a Path (sentence).  Multiple 

Paths (sentences) create a Shape (paragraph). 

line + line + line… = path 

path + path + path… = shape 
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The Primitive Types 

 

Straight Line (Ctrl + L)   

The Straight Line draws a continuous Line between the Start point and End point (the black Line shown in the 

following diagram). 

 
 

To draw a Straight Line, select the Straight Line type.  Right click anywhere there is a clear space on the 

drawing grid.  This will place the Line Start point.  Right click in another clear space to set the Line End point.  

The Line will be drawn between the two points. 

Drag either of the points with the left mouse button to adjust the length and angle of the Line. 

 

 
 

To draw a connected series or Path of Straight Lines, add more points by right clicking.  The new Lines will be 

added in a continuous sequence or series.  Each new Line will be connected to the previous Line's End point. 
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Cubic Bézier (Ctrl + B)   

The Cubic Bézier draws a continuous smooth Curve between the Start point and End point (the blue colored 

curve shown in the following diagram). 

Two Control points are used to independently adjust the amount of curvature and the magnitude at opposite 

ends of the Curve. 

 

 
 

The Start and End points can be moved as described above (i.e. drag with left mouse button - see Straight 

Line).  Similarly, either Control point can be dragged with the left mouse to relocate it.   

The Control Points are connected to their parent point via a line segment.  The rotation or angle that the line 

segment makes adjusts the curvature.   

Drag the Control point further away from the parent point to increase the magnitude of the curvature.  Dragging 

the Control point closer decreases the magnitude of the curvature. 

 

 
 

To draw a connected series or Path of Cubic Béziers, add more points by right clicking.  The new Curves will 

be added in a continuous sequence or series.  Each new Curve will be connected to the previous Curve's End 

point. 

 

 
 

Manipulating a control nub in a series of Cubic Béziers changes the curves adjacent to the altered control nub.  
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Quadratic Bézier (Ctrl + Q)   

The Quadratic Bézier draws a continuous smooth curve between the Start point and End point (the tan colored 

curve shown in the following diagram). 

 

 
 

The Curve is governed by a single Control point.  The Control point is used to simultaneously adjust both the 

amount of curvature and the magnitude.  Two line segments give visual cues to the angle and magnitude of 

the Curve. 

The Start and End points can be moved (drag with left mouse button - see Straight Line).  Drag the Control 

point with the left mouse to similarly relocate it. 

 

 
 

To draw a connected series or Path of Quadratic Béziers, add more points by right clicking.  The new Curves 

will be added in a continuous sequence or series.  Each new Curve will be connected to the previous Curve's 

End point. 

 

 
 

The Quadratic Bézier has a special modifier: the Alt key.   When the curve is being manipulated, the Alt key 

restricts the location of a Start/Mid/End point to the line segment on which it lies. 

In the following diagram, imagine that the Alt key is being held down while the lower left point is being dragged.  

The placement of that point will be restricted to anywhere along the red line as long as the Alt key remains held 

down. 
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Releasing the Alt key returns the placement of the point to the normal range. 

When a series or Path of Quadratic Béziers has been created, the Alt key modifier used on a mid-point 

transforms the two adjacent control lines to become a single line between the two control points.  The point 

being dragged is restricted to this line. 

In the diagram below the red point is being dragged.  With the addition of the Alt key, the point is restricted to a 

straight line between the two adjacent control points. 
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Elliptical Arc (Ctrl + E)   

(Dwarf Horde would like to acknowledge and give credit to svg.codeplex.com for the Elliptical Arc Algorithm) 

The Elliptical Arc type draws an elliptical curve from the Start point to the End point (the red curve shown in the 

following diagram). 

 

 
 

The Elliptical Curve is governed by three Control points; one each for Rotation, Y-radius and X-radius. 

 

 
 

As with all other Control points, Left -click and hold to drag the point to a new location.  The length of the line 

segment gives a visual clue to the magnitude while the angle of the rotation line segment determines the 

angle. 

Note:  If the X-Radius and Y-Radius Control points are of the same magnitude (i.e. superimposed on each 

other) the Curve will be circular and the rotation control will have no effect. 
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The Large/Small Arc button  is used to 'flip' the region of a Curve that is drawn.  In the following 

diagram, two ellipses have been drawn with the same parameters.  The only difference is the state of the 

Large/Small Arc button. 

 

 
 

We can see that the two curves would form a complete ellipse if one were rotated by 180 degrees and 

superimposed. 
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The Sweep Direction button   determines which direction the Ellipse is drawn between the Start 

and End nubs. Toggling this checkbox inverts the Ellipse. 
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The Smooth Types 

Cubic Spline (Ctrl + P)  

The Cubic Spline is a modifier for the Cubic Bézier curve. 

Visually, the Cubic Spline button turns a Cubic Bézier curve into a Cubic Spline by removing the extra control 

nubs, leaving only the nubs which actually lie on the curve. The behavior of these nubs differs from the Cubic 

Bézier in that the curve is adjusted beyond adjacent control nubs when relocating a nub. 

 

 
 

 

If you want to manipulate a small section of a curve use a Cubic Bézier.  If you want to change the entire curve 

use a Cubic Spline. 

Note that once a Cubic Spline is committed to the Path List it loses its modified state and is returned as a 

series of Cubic Béziers. 

The Dwarf Horde would like to thank Rick Brewster for generously donating the code backing Cubic Spline. 

Thanks Rick! 
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Smooth Cubic Bézier (Ctrl + Shift + B)   

Naturally this is a similar curve to the Cubic Bézier.  The difference is how joined Curves are linked by common 

Control devices which ensure that the Curve is... 

A. Is continuously smooth from one end to the other, and 

B. Extends through the center of all Start, Mid and End points. 

A single instance of a Smooth Cubic Bézier looks like the following diagram.  Note the single Control point. 

 

 
 

When a second Smooth Cubic Bézier is chained to the first to create a Path, the common point shares a pair of 

Control points which are linked.  The two Control points pivot about the common point much like a binary star 

or a seesaw. 

 
 

These twin Control points affect the Curve either side of the common point.  Length of the line segments 

determines magnitude of the Curve while the rotation affects the curvature. 
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Smooth Quadratic Bézier (Ctrl + Shift + Q)   

 

Naturally this is a mathematically similar curve to the Quadratic Bézier.  However it appears quite different.  

The difference is how joined Curves are linked.  Gone are the Control points.  Instead, the Curve is changed by 

dragging the Curve's common points.  Like the Smooth Cubic Bézier, this Curve is... 

A. Is continuously smooth from one end to the other, and 

B. Extends through the center of all Start, Mid and End points. 

A single instance of a Smooth Quadratic Bézier looks like a Line.  See the following diagram.  Note the 

complete lack of Control points. 

 
 

When a second Smooth Quadratic Bézier is chained to the first to make a Path, the common point becomes a 

Control point. 

 
 

The Common points affect the curvature either side of the point.  In the following diagrams, only the central 

Control point has been moved.  The Start and End points remain in the same position. 
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The Compound Types  

Auto Rectangle (Ctrl + R)   

 

This is a macro type tool which simplifies the creation of rectangles.  This combination type draws a Rectangle 

between Start and End points. 

 
 

Internally the Rectangle is converted to four ordinary Straight Lines.  It's much easier to draw this way! 

If multiple Rectangles are chained together (a Path), each new Rectangle will use the previous one's End point 

as its Start point. 

 

 
 

If a common point is relocated by dragging, both Rectangles will have their size affected. 

Rectangles in a Path may be overlapped.  In the following diagram, the last Rectangle in the diagram above 

has been dragged to a new location (colored yellow for clarity). It now overlaps the second Rectangle in this 

Path of three Rectangles. 

 

 

 
  



ShapeMaker User Guide – 44 

 

Auto Circle (Ctrl + I)   

This is a macro type tool which simplifies the creation of circles.   

The tool draws two semicircles from Start point to End point - but in opposite directions.  The result is a full 

Circle with the diameter equal to the distance between Start and End points. 

 

 
 

Internally the Circle is converted to two semi-circular elliptic arcs with an opposite Sweep Direction.  Once a 

Circle is committed to the Path List it is shown as two Elliptical Arc entries.  The Circle ceases to be a single 

unit when it comes to re-editing. 

 
 

Multiple Circles cannot be chained together to form a Path.  Each Circle forms a pair of Elliptical Arcs. 

If the Start or End point is moved, the size of the Circle is changed.  Drag the points further apart to make the 

Circle larger.  Drag the points closer together to make the Circle smaller.  Dragging one point clockwise or anti-

clockwise about the other rotates the Circle about the stationary point. 
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Creating Points 

Right click any clear space in the drawing grid to create a new point. 

 

   
 

A Start point for a new Line, Curve or Path is drawn as a triangle so the direction of the object can be easily 

discerned at a glance. 

If Snap-To-Grid is enabled, the point will be created on the nearest grid boundary.  If Snap-To-Grid is disabled 

the point will be created where the mouse cursor is located. 
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Creating Primitives, Smooth Types or Compound Types 

Right click any clear space in the drawing grid to create a new Start point.   Right click on another location to 

place the End point.  The currently selected Primitive/Smooth/Compound type will be drawn between the two. 

 

                    
   Straight Line   Ellipse   Cubic Bézier  Cubic Spline 

 

            
      Quadratic Bézier          Auto Rectangle  Auto Circle 

 

 

If the Type has associated Control points these can be moved just as any other point while the current object 

remains active (the Control nubs are visible). 

 

Tip!  Hold the Ctrl key down while dragging a point or nub to hide the control nubs, control lines and points.  

This makes viewing the Curve easier.  Release the Ctrl key to show these guides again.  

Smooth types can be drawn as individual elements; however they are intended to be used in series. 

 

                  
         Three Smooth Cubic Béziers        Three Smooth Quadratic Béziers 
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Moving Points and Objects 

When a Line/Curve is active:  

Drag any visible point with the left mouse button to adjust its position. 

 

If a nub that is linked to another is moved, both nubs will be moved in unison. Thus, any two linked paths 

remain linked. (Press the Alt key to disable this behavior) 

 

If a Start/End nub is dragged very near another Start/End nub from a different path, the dragged nub will snap 

to it. This feature makes it easy to link existing paths. (Press the Alt key to disable this behavior)  

 

If Snap-To-Grid is enabled  (Ctrl + S), the point will be relocated only to grid boundaries.  

If Snap-To-Grid is disabled  the point can be located anywhere in the drawing area. 

 

Hold Shift while dragging any nub in the currently active object to move the entire object.  

 

Hold the Ctrl key down while dragging a point or nub to hide the control nubs, control lines and points.  This 

makes viewing the Curve easier.  Release the Ctrl key to show these guides again. 

By default the last point in the previous object is used as the start point for any subsequent objects.  This links 

them together via a common point.  If this behavior is not desired, deselect the Linked Lines option  (Ctrl 

+ 3).  When Add Path (Enter) is clicked the last point will not retain the editing focus.   

If a separate object is desired, click Deselect (Esc key).  This allows the next created point to be located 

anywhere.   

 

When no Line/Curve is active:  

Holding Shift while dragging moves the entire image. 

Clicking near an End point or crease on a Line/Curve on the Drawing Grid will select the associated Path.  The 

Path will be selected (i.e. made active with the Controls showing). 
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Operations Box (Mini Controls) 

Press Ctrl + M to show the mini controls. These will appear at the bottom-right corner of the selected path or 

shape. 

Alternatively, you can Ctrl + Click on a nub to show the mini controls, and they will appear at the bottom-right of 

that nub. 

 

 
 

When the Operations Box is open, Path(s) that will be affected are highlighted in yellow. Contiguous (linked) 

Paths are automatically affected by operations to any Path in the group. 

 

On the far left of the Operations Box, there is the grip. This allows you to freely reposition the Operations Box 

without performing an operation. 

 

From left the controls are: 

● Scale 

● Rotate 

● Move/Pan 

 

To use a mini control, left-click and drag it. 

Scale  

The Scale control scales the Path or shape. Scaling is performed from the center of the shape or path 

depending on which is active.  

Scaling is a function of the distance from the control to the centre of the path or shape.  

Rotate  

Click & drag the rotation mini control to rotate the path or shape (depending on which is active).  

Hold the Shift key to constrain the rotation to 15 degree increments. 

Move/Pan  

Click and drag the move control to pan the shape or path about the drawing surface. 
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Quick Reference  

Primitive Types 

 
Primitive Path (Series) Closed Form 

Straight Line 

 
  

Ellipse 

 

No Series. 

Individual Ellipses form their 

own complete Path. 

 

Cubic Bézier 

  
 

Quadratic 

Bézier 
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Smooth Types 

 
Smooth Type Path (Series) Closed Form 

Cubic Spline 

    

    

 
 

Smooth Cubic 

Bézier 

 
  

Smooth Quadratic 

Bézier 

 
  

 

Compound Types 

 
Compound Type Path (Series) Closed Form 

Auto Rectangle 

 
 

No closed form 

Auto Circle 

 

No Series. 

Circles are formed from 

two Ellipse Paths. 

No closed form 
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Mouse & Keyboard Shortcuts 

 

Ctrl + L Straight Lines 

Ctrl + R Auto Rectangle 

Ctrl + I Auto Circle 

Ctrl + B Cubic Bézier 

Ctrl + P Cubic Spline 

Ctrl + Shift + B Smooth Cubic Bézier 

Ctrl + Q Quadratic Bézier 

Ctrl + Shift Q Smooth Quadratic Bézier 

Ctrl + E Elliptical Arc 

  

Ctrl + Z Undo 

Ctrl + Y Redo 

Ctrl + S Snap to Grid 

Ctrl + 1 Loop Path 

Ctrl + 2 Close Individual Path 

Ctrl + Shift + 2 Close Contiguous Paths 

Ctrl + 3 Link with previous Line 

Enter Add Path 

Esc Deselect 

Ctrl + M Opens the Operations Box 

 

Right Click on Drawing Grid to add a Nub 

Right Click on a nub to delete that nub (you can not delete the first nub in a Path) 

Left Click + Hold a nub or handle to drag it to a new location 

Left Click (no Path active) on the end or corner of any Line or Curve to select 

Left Click + Shift Key Click and drag a nub to move the Line/Curve or entire Path. 
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Left Click + Shift Key (no Path active) click and drag on clear space to move the entire Shape. 

Left Click + Alt Key Disables Magnetic Nubs and Nexus Nubs. 

Left Click + Alt Key (on a Quadratic Bezier Nub) moves nubs along control lines. 

Left Click + Ctrl Key hides the control nubs and points to better view a Line or Curve. 

Left Click + Ctrl Key (on a Nub) opens the Operation Box 

Wheel Scroll Zooms in/out 

Wheel Click + Hold (when Zoom is active) pans the entire Drawing Grid. 
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